USING THE PRAGMATIC CONCEPT OF BACKGROUND KNOWLEDGE TO ANALYZE THE TECHNICAL AUDIENCE

JANET GILTROW
SIMON FRASER UNIVERSITY

I

Pragmatics identifies Background Knowledge as comprising assumptions necessary for the interpretation of a text but unstated by it. A writer who accurately estimates the Background Knowledge resources of the reader will produce an accessible, efficient document. A writer who over- or under-estimates the reader's Background Knowledge resources will produce a less accessible, less efficient document.

The writer's presuppositions of Background Knowledge leave traces in the document: features like definite reference, deixis, redundancy and coherence can be analyzed to reveal the kind of reader the text identifies and the kind of Background Knowledge the writer presupposes on the part of the reader. Moreover, we could assume that writers working in particular genres—such as technical instruction—will be directed in their presuppositions of Background Knowledge by the distributing of knowledge characteristic of that genre's contexts-of-use. In the genre of technical instruction, that distribution may be principally characterized by a striking asymmetry: the writer is, at first, unequally endowed with technical know-how, while the reader is, at first, disproportionately deficient in know-how.

This paper first, using general examples, establishes the kind of linguistic evidence Background Knowledge presuppositions leave behind the text. It then goes on to analyse three samples of text from a technical manual. The results are interpreted in such a way as to suggest two, often competing, facets of the genre of technical instruction: the evidence indicates that, on some occasions, the reader is narrowly identified by
knowledge of entities situated in the physical context-of-use, while, on other occasions, the reader is only loosely identified—so loosely identified that we may have to talk about 'readers' rather than 'reader'. For the writers of technical instruction, the conditions represented by these conflicting constructions of the reader have implications, and the conclusion of the paper outlines these implications.

EVIDENCE OF THE PRESUPPOSITION OF BACKGROUND KNOWLEDGE

Definite reference can be a sign of Background Knowledge (BK) presupposed by the producer of the utterance. In

(1) Take the car.

the speaker assumes that the addressee possesses knowledge which will enable her to identity which car is in question — without hearing further explanation. This assumption identifies the addressee as a person who possesses this knowledge, and can, with this knowledge, interpret the utterance. As an instruction, (1) also presupposes procedural Background Knowledge: the addressee is constructed as someone who knows how to drive. We can look at (1) not only as a record of an utterance but also as a record of the speaker's assumptions about his or her audience.

The concept of Background Knowledge can also explain the conversion of discourse entities from unknown to known — from indefiniteness to definiteness:

(2) I saw a car approaching from the west. By the time I'd answered my cellular phone, the car had turned off.

Sample (2) demonstrates Background Knowledge as a function of co-text: the speaker's second sentence assumes that the first sentence has established a knowledge entry which the addressee can consult in interpreting the car. Similarly, in (3), below, the speaker assumes BK of driving and cars which will enable the addressee to interpret the definite expression the gas in the second sentence:
(3) You could drive to Seattle. But then who would pay for the gas?

With BK of driving and cars, an addressee not only would find the reference of the gas uninterpretable, but also would question the relevance of the second remark to the first — despite conjunctive ties but and then. So BK helps to explain coherence as well as reference. Sample (3) is designed for an addressee whose Background Knowledge Entry for 'driving' contains, among other things, assumptions about the use of cars and their consumption of fuel. For this addressee, the utterance is coherent.

So far, BK identifies audience as addressees with these available entries, and, where co-text is involved, as addressees who have (recently) experience preceding text. Co-text is one element of context. Other elements of context are also important constituents of BK. We could call them situational constituents. Thus, deictics are explained by BK.

(4) Put that there.

would be interpretable only by an addressee with access to the physical context of the utterance. Background Knowledge of this context would enable the addressee to interpret place (here), identify (that), and time (Put). The speaker has constructed the addressee as someone with this immediate situational experience. This may be a temporary and also a rather superficial construction of the listener, but we will find that it can also be a precise or definitive way of identifying the addressee.

Background Knowledge also helps to explain judgements — or interpretations — of the overall communicative relevance of an utterance, as distinct from the relevance of one sentence to another. For example, a municipal document may notify readers that

(5) Outdoor burning will be permitted April 25-27.

The author of this notice presupposes a Background Knowledge Entry (BK/E) which organizes the reader's knowledge of the topic and includes assumptions about what is burned outdoors and by whom, about the size
of the fires, and so on, and also assumptions about the civic regulation of such burning, and penalties associated with unsanctioned burning. This information is unstated by the writer, and his silence in effect defines the addressee. As well, the writer assumes that, in the appropriate reader's context of interpretation, there will be a BK Entry which contains assumptions about his or her accumulation of garden refuse or other unwanted items. The notice will interact with this knowledge, and the interaction will make (5) relevant to the reader. Owing to this interaction, (5) is immediately useful information for this person, practically improving her knowledge of the world. It has contextual implications (Sperber and Wilson 1986).

On the other hand, apartment-dwellers in the same municipality may have no such BK — no Entries in which they store knowledge of the accumulation of their garden refuse, because they don't have any garden refuse. To these readers, (5) will not provide relevant, immediately useful information. Having no contextual implications, it leaves their knowledge of the world unchanged. If some of these people suddenly move into a house before April 25, and have packing boxes to get rid of, (5) would become relevant. But, if on their one exposure to (5) they had no moving plans and no such context within which to interpret it, chances are they will forget it before the burning days arrive. In examining technical instruction, we will find that, if on their first encounter with information readers have no context for interpretation, the information may not be memorable.

If an occupant of a detached dwelling receives (5) in her mailbox on April 10, and then receives the same message in her mailbox on April 11, the April 11 proposition will exactly match the April 10 proposition and replicate an assumption already recorded in a BK/E 'outdoor burning.' It will be redundant, and not relevant. The reader may think there's been a mistake. In effect, the producer or producers of the second instance of (5) have misunderstood their audience, telling the reader something the reader already knew as if he or she didn't know it. On the other hand, a repeat notice a week later might be interpreted as a reminder, a strategic strengthening of the earlier entry, and the householder may interpret it as relevant.
Background Knowledge also plays the crucial role in implicature—the non-literal or non-conventional interpretation of utterances. Sample (6) below comes from an early page of the computer manual this paper will investigate—the Macintosh Plus Owner's Guide. The passage in which (6) occurs instructs the reader on unpacking and setting up her new computer.

(6) If you have everything, fill out the registration card and mail it in.

The proper execution of this instruction depends on BK/Es of 'mailing,' of 'registration card(s),' of 'computers' or machines in general. A reader who interrupted her setting up of her new computer to go out to the mailbox would have failed to follow instructions. However, a writer who included information about mailing things or told the user to mail the card later, not now, would have made a mistake similar but not identical to the mistake of the clerk who sent two notices to the same householder. Most readers of computer manuals know about mailing and registration cards and would be disconcerted to be told about these things as if they didn't know.

Finally, the concept of Background Knowledge helps to explain why a passage like (7) below can be acceptable to each of two addressees, but more meaningful to one than the other.

(7) Ramona is going on a cruise. Three of us are having a bon-voyage luncheon for her.

An addressee who has full, rich Background Knowledge Entry for 'Ramona' (we'll call this addressee A) would find (7) interacting or combining productively with assumptions in this entry. These eligible assumptions might look like this:

BK/E Ramona:
worked in the same office as both speaker and addressee
office : staff of twelve
has never taken a long trip
has just separated from her husband
In this context, (7) is very relevant, and meaningful, and interesting. However, for addressee B, who is hearing of Ramona for the first time (or who may have heard her mentioned before but who has had no reason to use the materials of this previous Entry in the meantime so has allowed it to lapse, retaining at best only the name and the inference of association with the speaker), (7) is out on the very frontiers of relevance. Her Background Knowledge Entry for 'Ramona' is nearly vacant:

**BK/E: Ramona:**

is someone the speaker knows (inference from utterance)

B's understanding of (7) is shallow compared with A's. Chances are, B will forget about Ramona again, having so little BK for this utterance to interact with. We could say that the speaker has been mistaken in his or her construction of audience.

All of these occasions for the operation of Background Knowledge bring up issues important to technical instruction, where it is not enough for writers to know all about technicalities. They also must be able to construct knowledge of the reader's knowledge, and speak out or remain silent accordingly.

**METHOD: FORMS OF ANALYSIS**

To observe the operation of Background Knowledge in a technical document, I have analyzed three passages from the *Macintosh Plus Owner's Guide*. Two of these passages come from the beginning of "Chapter 1 Learning Macintosh Basics": "Unpacking" (Appendix A) and "The tutorial." (Appendix B) The third passage — "Desk Accessories" (Appendix C) — comes from the middle of "Chapter 3 The Macintosh Plus: Reference."

To conduct these analyses and interpret the data, I rely on several theoretical sources. The specific concerns of each of the researchers who provide these sources are diverse: they are by no means all pursuing the same theoretical goals, and they are each concerned with distinct
problems in the analysis of discourse. But each depends on the concept of Background Knowledge in conducting his or her research into these different problems. In this paper I try to bring together work on given and new; on relevance; on definite reference; and on coherence and redundancy. I will very briefly summarize these sources, giving more attention to the first one because of its prominent role in the findings which follow.

Prince's taxonomy of given and new (1981) provides measures of referring expressions' "assumed familiarity" to the reader. The taxonomy recognizes that entities enter a discourse through a variety of conditions. It offers five categories of familiarity, two with subsets.

1. **Brand-new, unanchored:** A Macintosh disk is recording information. **Brand-new, anchored:** A message on the screen welcomes the user to Macintosh. (The reader is not familiar with this message, but does know about the screen, which helps her construct an identity for *message*.)

2. **Unused:** Select from the File menu.

3. **Inferrable, non-containing:** Plug in the computer. When the power is on....(The power has not been mentioned, but the reader can infer what power is in question by consulting Background Knowledge about plugging things in.) **Inferrable, containing:** The label on the disk in the packing box says "Utilities." (The label has not been mentioned before, but the reader can figure out what label is in question from the expression itself, which contains expressions of referred-to entities assumed to be familiar.)

4. **Situational:** Open the packing box. (The packing box has not been mentioned before, but the reader is familiar with it because it is present in her physical environment at the time of reading.)

5. **Textual:** Keep the packing box. (The packing box has already been mentioned, entering the discourse as a *Situational* entity.) **The disk** records information when you select Save. (The disk has already been mentioned, entering the discourse as a *Brand-New* entity.)
Prince found that her taxonomy worked very well in analysis of an oral narrative, and not so well in analysis of written scholarly exposition. I found that it worked fairly well for technical instruction (which suggests that technical instruction may fall somewhere between these two forms).

Sperber and Wilson's proposals for the analysis of relevance (1986)

While most entities were easily classifiable, certain expressions were restless, refusing to settle down into a stable category. Some plural nouns without definite determiners did not seem to fit as comfortably into Brand-New as others did. Compare (1) and (2) below:

1) **Icons** appear on the screen.

2) You can move **folders**.

Whereas in (1) particular icons seem to be in question, that does not seem to be the case in (2). Yet familiarity with folders in general does contribute to the meaningfulness of (2): the whole class of folders rather than particular folders are in question. **Folders** seems to be Unused rather than Brand-New, and I have treated similar expressions as Unused, employing an existential-**there** test to distinguish between these two types of expressions. (See L. Rodman, 'Some functions of existential **there** in scientific discourse,' Paper presented at meeting of CATTW/ACPRTS, June 1991.) Whereas (1) is transformable by existential-**there** —

(3) There are icons that appear on the screen.

— (2) doesn't seem to be eligible for the same transformation. As far as I can tell, (4) below does not represent the same assumptions about Background Knowledge that (2) does:

(4) There are folders that you can move.

At the same time, the singular indefinite determiner is not entirely a sure-fire sign of Brand-Newness. In (5) below a **document** seems equivalent to **any document** and thus is susceptible to the 'whole class' argument above and does not pass the existential-**there** test:

(5) You can move a **document**. ——>? There is a document you can move. Perhaps this should be looked into. In the meantime, I have treated all singular indefinite expressions as Brand-New, but **any + NH** expressions I would treat as Unused.
are the basis for estimating the content of Background Knowledge Entries, and the strength of this content, and for predicting the possibility of contextual implications in estimating the meaningfulness of a proposition. Clark and Marshall's work (1981) on the role of "mutual knowledge" in definite reference confirms that ways of speaking segment audience into populations with access to encyclopedic entries containing community-specific knowledge. Clark and Marshall's particular contribution to this project is the diary which is the encyclopedia's companion volume: we not only possess Background Knowledge, but also knowledge of when and how we acquired that BK, and from this knowledge we are able to estimate who else might have that BK. I convert the diary idea into support for analysis and estimate of the reader's BK/Es' history: where did the reader get this knowledge — from the text alone, or from experience? How long ago? Siklaki's (1988) research establishes the clearest connection between Background Knowledge and coherence, investigating the role of redundancy in describing a text's coherence, and explaining how a text's coherence can be shallow for one reader, and less so for another reader with richer Background Knowledge. Analysis of deixis relies on Levinson's summary (1983) of research on this phenomenon; analysis of cohesion follows Halliday and Hasan's (1976) method.

METHOD: IDENTIFYING THE READER

In its "Preface," the Macintosh Plus Owner's Guide identifies three audiences. It does so in terms of these audiences' Background Knowledge, suggesting that the producers of this book are intuitively or theoretically aware of the kinds of communicative situations we've just been looking at. "The beginner" is a reader who has "never used a Macintosh computer before" (xiii), i.e., someone who has no BK/Es or virtually empty ones for the discourse entities related to the Macintosh Plus. The beginner is directed to "Chapter 1" and the "tutorial," and to use "Chapter 3" "for reference," that chapter providing information she is "less likely to need to know right away." "The already initiated" is a reader who has "already had some experience using a Macintosh computer" (xiv). This reader is directed to skip Chapter 1, and to read Chapter 3 "for a major review of Macintosh Plus features." "The advanced user" is
quickly warded off — "This manual is not a technical reference manual" — and directed to "Appendix A" for "some technical information," and to a variety of other sources of information. The analyses which follow depend on the characterization of the reader as the "beginner" — someone who has "never used a Macintosh computer before."

II

MEETING THE MACHINE: INSCRIBED SITUATION

We might say that almost anybody could understand "Unpacking" (Appendix A): all kinds of people would be able to follow. Yet this accessibility is in fact achieved by a very narrow definition of the reader, one rooted in situation.

Despite the reader's lack of familiarity with Macintosh computers, no discourse entity is introduced as Brand-New, except as an element of a containing Inferrable (see analysis Appendix D.) And in these cases, the Brand-New entities are non-technical. The few Inferrables depend on only the most generally available assumptions: e.g., that something has to be done; the sort of distance over which one drives or flies.

Most items make their way into the discourse through the Situation category, or through a special, situation-based occasion for the Unused category, which we will look at in a moment. That is, entities from the physical environment of reading constitute the main textual knowledge that is assumed and built on by the writer as the passage advances. Entities which Prince's taxonomy classifies as Situational are equivalent to person deictics. All of these are reader- rather than writer-centred.

The Unused category — constructing the reader as someone with stored knowledge pertinent to this occasion — is almost empty except for one entity applications (S4) which is firmly pushed away from the reader's immediate concerns, and one other substantial, prominent entry: the long list of items in the box. In the absence of determiners, these expressions seem to be functioning something like Proper Nouns, so they earned this classification. Yet many of these items (e.g., Utilities disk)
are presumably unheard-of until now. It seems to be their presence in the reader's physical setting that justifies their treatment as already known. Notice, though, that if some of these items, treated by the text as Unused, are in fact unfamiliar to the reader, and treated as Unused only by virtue of their physical immediacy, then her BK/Es for them have two important characteristics. For one thing, they are very recent entries. For another thing, they are almost empty of assumptions.

Mailing the card, contacting the dealer, and travelling are all exterior to the immediate physical occasion. Interestingly, these concerns do not show up in the passage's cohesive ties which strongly favour local items. All three are touched on without interrupting the connectedness of the passage. This tight cohesive structure conceals a significant rhetorical decision: the writer could have reserved the information about travel especially, and formed it as a 'reference' entry later in the Guide. After all, the reader is not going to take a trip right now, so she has no immediate use for this information: it will not interact productively with situational Background Knowledge, although she can act immediately on the instruction to not discard the packing materials. By the time she does make a journey, she may have forgotten the instruction, like the apartment-dweller who disregards the municipal notice. Cohesive ties show that this information is adjacent to and accessible from the passage's main focus, but from the ties alone we cannot estimate the shelf-life of the information about travel or even about the registration card.

STARTING TO USE THE MACHINE

After "Unpacking," the reader is instructed on how to connect the parts of her computer system, and how to plug the whole thing into a wall outlet. Then she is offered the choice between learning about her machine from an instructional disk or from the User's Guide. Our hypothetical reader chooses the Guide, and encounters "The tutorial" (Appendix B). The tutorial divides itself at S14 (mid-sentence, in fact). The division is not marked graphically but is observable by measures which trace the configurations of Background Knowledge assumed by the writer (analysis in Appendix D's "the tutorial" shows this division:
part-way through, expressions begin to accumulate in the inferrable column.

The first section: situational monitoring fuses text with the context of reading

Like "Unpacking," the first section (S1-S13) of "The tutorial" (Appendix B) relies on Situational entities: the screen, the blinking question mark, the soft hum; and (supported by an unlabelled graphic) the disk drive; the disk labeled System Tools, and (originally Situational) the Macintosh Plus. (See analysis Appendix D "The tutorial".) The last three entities form the main membership of the Textual category. But S1-S13 also depart from the style of "Unpacking," presenting seven entities as Brand-New to the reader. These all represent features of the technical situation: A beep, a yellow sheet of plastic, An icon (a small picture) representing a Macintosh disk, a disk, a message. Some of these refer to specific changes in the physical context: beep, yellow sheet, icon, message. In a sense, these Brand-New entities are not exactly unknown to the reader, for they are present in the physical context (if she follows instructions), and other entities which share the same status as these ones are expressed as Situational entities: the blinking question mark, the soft hum. These expressions which select indefinite rather than definite determiners are signs of stylistic choice — the writer could have used definite determiners as he or she did for hum and question mark, confirming these entities' availability in the physical context. The choice of indefinite determiners seems to be part of a larger strategy, for it cooperates, as we will see, with another stylistic feature of this section — redundancy.

We reflected earlier on redundancy in estimating the response of the householder who received two municipal notices about outdoor burning. She thought there had been a mistake: the second message was redundant, exactly replicating information she already had, and not relevant. The principles behind that kind of analysis suggest that there is some redundancy in this section: "the disk 'kerchunks' into place....A message appears, welcoming you to Macintosh." If the reader has in fact followed instructions, she knows that "the disk 'kerchunks'" and that a message welcomes her. Strictly speaking, these propositions
are redundant — contributing nothing to the reader's knowledge of the world. These seemingly redundant propositions may cooperate with the indefinite (Brand-New) expressions to fuse text with the physical context of reading. The stylistic choice of indefinite expressions marks change in physical context — more important in technical instruction, perhaps, than in other kinds of information. The indefinite expressions configure change grammatically, illuminating it in the text as definite expressions would not. At the same time, the seemingly redundant claims monitor the changing situation. Both features contribute to a fusion of text and context. And they are supported by another feature of this passage: discourse deixics (terms referring to the text itself) which fuse text with the context of reading.

The first appearance of discourse deixis — these steps (S1) — is equivalent to the one discourse deixic here (S2) in "Unpacking." The second and third appearance of discourse deixis create an occasion where the distinction between text and context all but disappears. Sentence 13 proposes that "[a] few seconds later your screen should look like this...." A large graphic representing the screen follows. This refers to text — the graphic. When this appears again (S14), we could see it as another discourse deixic, but we could also see it as a Situational entity (or person deixic) as well: this refers not only to the graphic but to the reader's computer screen as it now appears to her. By means of the graphic, this straddles the linguistic and non-linguistic settings — co-text and context. (We will see discourse deixics change dramatically later in the Guide.)

These data reveal a characteristic of the genre of technical instruction: the way graphics contribute to the fusion of text and context. From a strictly linguistic point of view, both the disk drive (S8) and the brightness control (S12) are expressed as Unused entities, but two unlabelled photographs at the bottom of the page show a user's hand fingering parts of the machine which the reader can infer to be, respectively, the disk drive and the brightness control. These graphics transfer entities from Unused (or Brand-New or Inferrable) category to Situational category. Along with indefinite expressions and redundant claims, they narrowly define the reader within the dimension of the physical context of reading.
The second section: non-situational entities change the status of information

It is in this environment — following the graphically evoked *disk drive* and *brightness control*, and the *this* which is simultaneously Situational/person-deictic and discourse deictic — that the text temporarily relaxes its grip on context. The explanation of the Finder (S14-S20) provides information that is relevant to the reader — the Finder is in front of the reader — but not as relevant as the preceding propositions which directed physical performance — the reader has no documents to move or open or work on. Recalling that, while most discourse entities are identifiable situationally, they are also represented in the reader's consciousness by recent and virtually empty Background Knowledge Entries, we could detect here a strategy intended to improve or stock one of these vacant entries. Remember, the richer the contents of the BK/Es, the more relevant and coherent the propositions touching them will seem. So the relatively lengthy description of the Finder seems to be an attempt to make the passage more meaningful, in this one respect at least. (Ramona's friend would be employing a similar strategy if he or she told Addressee B all about Ramona, so the information about the cruise and the luncheon would have more to interact with.)

However, this meaningfulness comes at some cost. Up until S13, Unused and Inferrable entities are much less common than Brand-New, Situational, and Textual (from Situational) ones. Once the explanation begins, conditions change. In S14-S20, Unused entities are numerous: *most computer screens, Macintosh terminology, documents, folders, things, the mouse*. And the incidence of Inferrables also increases. They seem to rely on rather general inferencing (*what you want to work on* (there's something you want to work on)) and from entities themselves Brand-New, Inferrable, or Unused: *the Macintosh Finder, a special application* (B-N + anchor) *you use to organize and manage your documents* (you have documents you manage and organize (I)) *or to start other applications* (there are other applications; they are started (I)). For the beginner (our reader), these entities will have little or no history; their attached BK/Es will contain no assumptions except those which can be derived from the text itself, on the spot. We might predict that,
under these circumstances, the coherence of S14-S20 will be shallow, and that contextual implications will be few.\(^2\)

When the explanation of the Finder is over, the text returns to its previous focus, recovering earlier discourse features:

(8) The bar at the top of the screen contains menus; you'll see how to use them a little later. The icons on your desktop always let you know what's available.

\(\textbf{The bar at the top of the screen}\) is a Situational entity, or person deictic (it may be discourse-deictic as well, for the graphic also shows the bar); \(\textbf{a little later}\) is time-deictic. (It is followed in S23 by another time-deictic \textit{right now}. Both time deictics re-establish time-of-reading as the basis for interpreting verb phrases — a basis that was suspended in S14-S20). Yet even as immediate context of reading reasserts itself, we can see the features of the explanatory, non-contextual mode persisting: \textit{menus} seem to be an Unused entity; \textit{what's available} is an Inferrable (things are available) in the general style of S13-S20. Moreover, while \textit{icons} (S22) bears a direct cohesive tie with \textit{(an) icon} (S6), this tie crosses 15 sentences (propped up by the label on the graphic) — a lengthy span, and much longer than the very short spans which are characteristic of these passages so far. And \textit{The icons on your desktop} is not in fact a reference tie (or Textual entity) but only a lexical tie (and an Inferrable). Also, while these sentences both render verb phrases in the simple present, time reference is not equivalent for all of them. Some are deictically anchored to the reader's immediate context; others are not.

---

\(^2\)In the first section of the passage S1-S13, one of the rare Unused entities appears when a similar attempt is made to explain: "The soft hum is the Macintosh Plus getting information from the disk." We could predict that the beginning user will have next-to-no assumptions in her BK/E for 'information' which will interact productively with the proposition about the hum. What she knows about 'information' won't have much to do with the electronic hum of the computer.
THE CONDITIONS OF TECHNICAL LEARNING IN "THE TUTORIAL"

Analysis of "The tutorial" demonstrates some conditions of technical instruction — or technical learning — for the beginning user of the machine: (1) reading and its context are fused by grammaticalization of non-linguistic context and a supporting system of redundancy — which may, in turn, control the reader's experience of his or her physical context; (2) the discourse constructs itself out of entities about which the reader has no or next-to-no assumptions except those which attach through a very brief situational and textual history. When the Guide departs from narrowly situational materials, it steps onto an uncertain strip of Common Ground. "Unpacking," in its mention of travel, also makes a gesture beyond situation, although in a more tightly cohesive setting. Here, in "The tutorial," we can similarly speculate on the durability of information equivalent to that expressed by the municipal notice to the apartment dweller who, at the time of reading, had no immediate context with which it could interact: will the reader remember all this about the Finder when the time comes?

At this point, we'll leave our "beginner" to the tutorial. We will imagine that the reader gets acquainted with the mouse, learns how to select from the menu; how to open, close, and move windows; how to create documents; and so on. We rendezvous with the beginner later, in "Chapter 3: Reference." But when we meet the reader there, he or she is nearly a stranger to us. What has the reader been doing in the meantime? What is the condition of the reader's Background Knowledge Entries for entities which this chapter wants to tell about and for entities which contribute to the telling? The reader may be as much of a stranger to the writer of the Guide, for 130 pages later, discourse conditions at first appear chaotic. Has the writer given up, withdrawn his investment in the situationally identified reader?

REFERENCE VS. PROCEDURAL MANUAL

In fact, what has happened is that, by Chapter 3, the writer has made choices resisted in "Unpacking" and "The tutorial." In "Unpacking"
he incorporated instructions on travelling with one's computer, weaving them into the episode — rather than reserving that information for a section called "Travel" or "Transport." And in "The tutorial" the writer paused to tell about the Finder — rather than partitioning and postponing this information. But in "Desk Accessories" (Appendix C) the writer has partitioned information. The Guide has become a reference manual rather than a procedural manual.

The first part of the Guide relied on the condition of procedural 'nextness' for coherence and relevance of its propositions: except for the section about the Finder, order of operations governed order of propositions. Although actual directives are few (two) in the tutorial passage we examined, they bring about the situational up-dating that is so important in bringing the reader into contact with strange things. In "Desk Accessories," 'nextness' no longer rules. In fact, this passage actually violates procedural order by dwelling on the closing of desk accessories before telling what desk accessories can be selected in the first place.

Reading becomes a pluralist rather than unitary system

Just as 'nextness' has gone out the window, so have the grammaticalizations of context and the situational monitoring. In "Desk Accessories," no Situational entities/person-deictics occur. The discourse does refer to itself three times, but only one of these references is truly deictic: later in this chapter (516). "Editing Text" in Chapter 2 and "Using Control Panel" in Chapter 2 both transform the text's mentions of itself from reference to the immediate process of reading into reference to other text (Unused or Inferrable). These mentions make no presuppositions about the reader's experience: he or she may or may not have read these other parts. Whereas mentions of discourse in "Unpacking" and "The tutorial" represented local-time reading, bonding reading with the operation of the machine, now mentions of discourse represent reading as a pluralist rather than unitary system: readers who don't know the information contained in "Editing Text" can go and look at it; those who don't remember this section can re-read it; others can continue. At the same time, there's nothing in "Desk Accessories" which requires that even the ignorant or forgetful reader return to
Chapter 2 to understand what's going on here. Because situational monitoring has dissolved along with 'nextness,' procedural BK no longer has the same status it had in "The tutorial." BK of clicking, choosing, dragging, and so on, is presupposed (like switching and inserting in "The tutorial") but a reader who doesn't know how to click or drag will not be stranded the way a "tutorial" reader who didn't know how to switch or insert would be. Now that the text-created situation has expired, and the intersections of text and context are dispelled, the reader can read without know-how.

Situational entities are displaced by Unused and Inferrable entities

In "Unpacking" and "The tutorial" nearly all Textual entities entered the text through some form of situational status. In these passages, there are no Situational entities, so Textual entities are formed from other types of information (see analysis in Appendix D's "Desk Accessories"). In "Desk Accessories" the principal (almost the only) Textual entity is desk accessories itself, which enters the discourse as Unused (i.e., known to the reader). Before we reflect on the significance of this assumption of Background Knowledge, and its effect on the relevance and coherence of the passage, we will examine the array of entities which here displace the Situational entities which distinguished earlier passages of the Guide.

While desk accessories is the Unused entity which forms the core of the Textual information, it is not the only Unused entity on which the passage depends. Most of these represent knowledge derived from using the Macintosh Plus: the Cut, Copy, and Paste commands, the Edit menu, text, pictures, most applications, documents, Close, the File menu, the Utilities disk, startup disk, the Macintosh Utilities User's Guide. But analysis of these items as Unused is problematic, for each has been mentioned elsewhere in the Guide, so, if we conceive of audience as someone who has read from page 1 to page 141 continuously — i.e., read

3Taken as a single referring expression, the Cut, Copy, and Paste commands in the Edit menu could be an Inferrable for some readers who didn't know where the commands were located, but they would still have to know where the Edit menu was for the inference to perform.
these pages as a single text — then these entities would be Textual. In fact, the problem in analysis illustrates a problem in technical instruction itself. If the learner's reading is interrupted, then knowledge acquired from text gets mixed with knowledge acquired from practical experience. When the learner returns to the Guide, particularly to the "Reference" chapter, his or her knowledge of, say, the File menu may have been initiated by the text, but it is also or principally composed of non-linguistic experience. Discourse mentions — e.g., See "Editing Text" in Chapter 2 — provide textual back-up for readers whose knowledge has a perishable basis in experience. But, on the whole, the entities listed above, given the intermittent nature of reading of manuals, and the twining of this reading with physical experience, are best seen as Unused. Writers who took them to be Textual entities would be presuming — as we see — a great deal about a reader's ability to retain abundant new entries, unconfirmed by experience, in his or her store of Background Knowledge.

Inferrables are as numerous as Unused entities. Some Inferrables are not challenging: e.g., their title bar (S7) desk accessories have something called a title bar). But others are more complicated: the desk accessories that are installed in the System File on the current startup disk (S11) (there are some desk accessories installed on the System File (Unused/Inferrable: there is a System File); the System File is on the current startup disk (Unused/Inferrable: there is a current startup disk)). The long postmodifier assumes not only inferencing stamina on the part of the reader but also the ability to retrieve Unused entities to perform these inferences.

Other inferences are challenging to the Beginner+ for slightly different reasons. An anchored Brand-New entity — some applications (Macpaint, for example) (S9) (there is a class of applications whose distinguishing characteristics are represented by those of Macpaint (Unused)) — presupposes a reader with some rather specific knowledge of Macintosh conditions. Even after turning the Unused expression into an Inferrable, the Beginner+ will be left with a very vague and not very useful assumption. Another Inferrable presupposes Background Knowledge that at first seems general enough to be constructed by most readers: instructions on how to add or remove desk accessories (S14)
(people remove or add desk accessories (Textual)). However, the inference performs with an entity which, although it is well established Textually, was first introduced as Unused: desk accessories.

Now that we have scanned this passage's cultivation of Unused and Inferrable entities, it's time to look at the consequences of hinging inference and many other reading operations on this entity desk accessories.

**Constructing knowledge of the unknown**

A reader who had never heard of desk accessories could infer from the expression desk accessories in S1 that there were such things as desk accessories, but she would find no linguistic acknowledgement that this condition of ignorance was entertained by the writer. (Compare the stylistically exaggerated care with which the writer introduced new items — beep, message, etc.— in "The tutorial.") Yet our Beginner+ is not an extreme case. While cruising menus, some users may have noticed the wording desk accessories, but this experience would not constitute a rich BK/E. The Beginner+ has been explicitly invited to attempt this chapter, yet he or she arrives to find that other kinds of readers have been invited, too. Beginner+ is met at the door by an Unused entity he or she has to treat as Inferrable. Then, MacPaint's status as Unused suggests preparations for a more widely experienced user, and the passage's rather lengthy focus on closing desk accessories suggests that some people have been using them already, and have trouble closing them. Just as this section of the Guide abandoned reading as an inscribable, traceable, controllable event, it also seems to have abandoned a unitary construction of the reader.

Leaving the more experienced readers to fend for themselves, we will follow the experience of our original, Beginner+. We don't know as much about the reader as we used to, but we'll make the most plausible estimates we can.

Beginner+ knows nothing or next-to-nothing about desk accessories. (These entities desk accessories may not even be present in the physical context of reading, for the passage does not induce the reader to get desk
accessories open.) We characterize the reader's Background Knowledge Entry for desk accessories before attempting page 141 this way:

BE/E desk accessories : Δ

Once the reader has arrived at page 141, BK/E becomes >Δ or

BK/E desk accessories :
  they exist (inferred from text (T →)) (new)

After reading S1-S2, the reader has an improved BK/E:

BK/E desk accessories :
  they exist (T →) (new)
  they are chosen from Apple menu (learned from text (T)) (new)
  they are available from the Finder or application (T) (new)

To these assumptions we could add a 'discourse inference' that desk accessories have some qualities or functions which make designers call them 'desk accessories' ('Macintosh terminology' seems to encourage such inferences, even drawing attention to opportunities for making them, as we saw in the discussion of the Finder's alias desktop in "The tutorial"):

  they are in some way like things people keep on their desks
  (BK/E desk things : blotters, pen sets, staplers, calendars, etc.)
  (D→) (new)

We keep in mind the principle that propositions achieve relevance insofar as they interact with context — i.e., with assumptions contained in BK/Es which have been opened either by co-text or by non-linguistic context. So from co-text we should add these BK/Es to the context:

  BK/E finder :
    screen's display at the start (known (K))
  BK/E applications
    word-processing program is an application (K)

Then we evaluate S3 for its relevance to this reader:

  You can use the Cut, Copy, and Paste commands in the Edit menu to move or copy text or pictures among desk accessories, or to and from a document in another window.
This sentence adds some other entries to context, which, for our Beginner+, look something like this:

**BK/E Cut, Copy, Paste commands**
they are available in Edit menu (K) or (T—>) (new)
they are for editing (K) or (T—>) (new)

**BK/E text or pictures**
word-processing input (K); images of concrete objects (K)

If we search the contents of the open entries, to find possible avenues of interaction, we come only to dead-ends. Nothing the reader knows about editing commands or work processing or pictures combines with what she is learning about desk accessories. Moreover, the tentative 'discourse inference' is now in jeopardy, for general knowledge of things usually called desk accessories (blotters, etc.) will not interact productively with S3: what would it mean to move a text or picture from a pen set to a stapler?

To this point, the analysis of relevance or coherence has scanned BK/E s opened by text and co-text. Beyond co-text, there may be elements in the reader's situation which open entries: like the householder who is harbouring a pile of garden refuse, the reader may have something in his or her life situation which interacts productively with this information, making it relevant. But the Beginner+ reader doesn't know what desk accessories are, and therefore cannot attempt to combine textual knowledge with other forms of knowledge. (Even someone with a big pile of rubbish who didn't know what outdoor burning was would not be able to discover the relevance of the municipal notice. This person would not understand it.)

Here we might speculate on the role of situation in technical instruction. Early in the Guide, situation is constructed by text: inside the very large, very general situation of owning a new computer and having to make it work, a narrower situation is built by the fusion of text and physical context. Relevance is based on this fusion, and coherence is a matter of 'nextness.' Once this introductory phase is over, situation is not created by the text but brought to the text by the reader. Relevance then depends very much on the cognitive identity of this reader — not
only in terms of the quality, recency and richness of the BK/Es opened by the text, but also in terms of the larger situation the reader has in mind.

By the time Beginner+ has read "Desk Accessories," he or she has accumulated many assumptions in her BK/E 'desk accessories.' All these assumptions are new. In this respect, we might like to think of the passage as highly informative. But so was the information about Ramona new to Addressee B, yet it was neither deeply coherent for that listener, nor relevant. Addressee B may or may not remember or may not attend to the discourse on Ramona, since it seems to construct a listener different from Addressee B. Similarly, Beginner+ may or may not grasp the discourse on desk accessories.

III

STYLE IN TECHNICAL INSTRUCTION

In terms of its configurations of assumptions about the reader's Background Knowledge, the style of the Guide is not consistent. Stylistically, the Guide stretches between two poles. At one pole, in "Unpacking," reading is embedded in physical context; physical context is inscribed in the text. Text creates situation; situation makes the text intelligible. Under these conditions, the reader is narrowly identified, constructed by the text along very exact specifications, fitted to a template. The strength of this bond between text and physical context is the basis of relevance and coherence. The tiny departures from immediate context to future context (mailing) and possible context (travel) cause scarcely a ripple in the connectedness of the passage.

At the other pole, in "Desk Accessories," almost all the linguistic features which inscribed situation are gone. So too is the unitary definition of the reader: the reader's experience is no longer controlled, and a wide range of assumptions are made about Background Knowledge. Relevance and coherence are no longer measurable by analysis of the text alone. Now readers bring situation with them, and a reader with none to bring along finds few contextual implications. The reader's
knowledge of the world is not significantly improved by "Desk Accessories."

Between these two poles, "The tutorial" demonstrates both the narrowly constructed reader, defined by situation, and the loosely identified reader, left alone to make meaningfulness. While the reader switches on the machine and inserts the disk, the text is inscribed with situation. But, when the Finder is explained, Situational entities are displaced by Inferrables and Unused entities. In other words, even this modest attempt of the writer to improve the reader's meagre BK/Es for just one of the situational entities dissolves the firm boundaries within which the reader's experience has been contained and monitored. By the time the Guide has advanced to "Desk Accessories," these conditions prevail, often confronting the reader with occasions for involved inferencing.

BACKGROUND KNOWLEDGE AND THE WRITER OF TECHNICAL INSTRUCTION

The difficulties our Beginner+ faces in "Desk Accessories" may be unavoidable in technical instruction: ignorance (i.e., empty or nearly empty BK/Es attached to main discourse entities) does not create coherence problems as long as situation is established and maintained by the text, but once situation withdraws, ignorance can create coherence problems. No doubt, it is not possible to build and constantly maintain a text-created situation that would endure for the length of a whole manual. But authors of technical instruction might keep a few ideas in mind.

For one thing, theories of Background Knowledge, and this analysis, suggest that an introductory overview is not a very practical strategy, logical as it may seem to the well informed writer. Even the modest attempt to introduce the Finder in "The tutorial" admits the features of style which cause Beginner+ problems in "Desk Accessories."

Second, authors of technical instruction could keep in mind the origin and history of Background Knowledge Entries that they are assuming. Is the assumed Entry strictly Textual, developing from Brand-New or
Unused/Inferrable status, rather than from Situational status? Or does it have a practical as well as textual history in the reader's mind? If it does have this practical history, it may be a stronger Entry, less perishable, confirmed and strengthened by use, and therefore more reliable. And how recent is the BK/E which the text presupposes? If it is new, and its contents have not been strengthened by either textual or practical use, or its relevance confirmed by contextual implications, it may be perishable indeed. It may already have erased itself.

Third, authors of technical instruction should respect readers' capacity for inference. For example, readers may confront an entity treated as Unused which is for them in fact unheard-of, but be able to treat it as an Inferrable. Although their particular Background Knowledge is not figured in the text, the readers can still eavesdrop — eavesdrop on a message designed for other people. However, readers' capacity for inference may be overtaxed by conditions like those in "Desk Accessories." When readers have to make too many inferences, they will find few features of style and expression which acknowledge their actual cognitive circumstances. Then they will not only be tired out with inferencing but also become suspicious that they are not at all the reader identified by the text.

Finally, authors of technical instruction could remind themselves of the cognitive significance of the decision to adopt a reference rather than procedural mode. At one level, the reference mode and format make the information status of many discourse entities unstable. If some things have been mentioned elsewhere, but either the reader has not read the passages in which they were mentioned, or the interruptions in his or her reading have left them inaccessible (both plausible circumstances), then their surface treatment as Textual will convert to Unused, bringing all the problems associated with inferencing. At another level, the reference format, which abandons situation and the unitary reader, seems to threaten textual coherence. A reader who does not bring along situation will find a passage's propositions not relevant, not coherent, and not meaningful (and possibly not even readable).

Since text-created situations probably cannot be maintained over long stretches of text, these problems associated with the reference mode
may be indigenous to technical instruction. Perhaps we should see them not as problems but as elements of the poetics of technical instruction. On the one hand, that poetics inscribes context on the page, fuses language and non-linguistic circumstances, constructs the reader or provides a template by which readers can construct themselves. The text's meaning is unitary and predictable, its reader narrowly identified and constrained. And, on the other hand, this same poetics on other occasions asks readers to carry situation, and thus the conditions of meaningfulness, to the text themselves. The text's meaning is pluralist and unforeseeable, its readers multiple, and footloose in the larger world.


RODMAN, L. (1991) Some functions of existential *there* in scientific discourse, Paper presented at meeting of CATTW/ACPRTS.


APPENDIX A

Unpacking

(1) The first things to do is make sure you have everything you're supposed to. (2) Take all the materials out of the packing box and see if you have everything listed here:

- Macintosh Plus main unit
- Power Cord
- Keyboard
- Keyboard cable
- Mouse
- *Macintosh Plus*, the owner's guide
- *Macintosh Utilities User's Guide*
- *Macintosh Quick Reference Card*
- *Your Apple Tour of the Macintosh Plus*
- *System Tools* disk
- *Utilities* disk
- Registration card
- Packing list
- Programmer's switch (3) (Set this aside for now. (4) You'll install it only if you're developing applications for the Macintosh Plus.)

(5) If you have everything, fill out the registration card and mail it in. (6) (The card asks for the computer's serial number, which you'll find on the bottom of the main unit.) (7) In the unlikely event that anything is missing, contact your authorized Apple dealer or representative.

* (8) Save the packing materials: Keep the box and all the packing materials. (9) Repack your computer system if you have to move it over long distances (that is, any distance that requires a car or airplane) to protect the system from rough handling.
The tutorial

(1) Follow these steps to start up the Macintosh Plus:

• (2) Switch the Macintosh Plus on if it's not already on.

(3) A beep lets you know it's started. (4) If this is the first time you've turned on the power, a yellow sheet of plastic will pop out of the disk drive. (5) Remove the plastic piece from the disk drive, but don't discard it; inserting it in the disk drive prevents damage during shipping if you every need to transport your Macintosh Plus.

(6) An icon (a small picture) representing a Macintosh disk appears on the screen. (7) The blinking question mark shows that the Macintosh Plus is ready for you to insert a disk.

• (8) Insert the disk labeled *System Tools* into the disk drive, metal end first, label side up.

(9) When the disk is most of the way into the disk drive, the Macintosh Plus automatically pulls it in, and the disk "kerchunks" into place. (10) The soft hum is the Macintosh Plus getting information from the disk. (11) A message appears, welcoming you to Macintosh.

• (12) You may need to adjust the brightness control to the level you want.

[two uncaptioned, unlabeled photographs: one shows a hand inserting a disk into the disk drive; the other shows a hand fingering the bottom left corner of the main unit]

(13) A few seconds later, your screen should look like this:

[a large graphic representing the screen, with the System Tool icon labeled "Icon"]

(14) This is the Macintosh *Finder*, a special application you use to organize and manage your documents and to start other applications.
(15) You use the Finder every time you start your Macintosh Plus, or whenever you move from one application to another. (16) It's like a "home base" for operating your computer.

(17) Most computer screens look like the departing flight schedules at a busy airport, but the Macintosh Plus screen looks like a light gray desktop. (18) In fact, the Macintosh terminology, desktop and Finder are often used interchangeably. (19) You can arrange your desktop any way you want – just like with a real desktop. (20) You can slide documents around, organize your work in folders, throw things away, or get what you want to work on next – just by moving the mouse and pressing the mouse button.

(21) The bar at the top of the screen contains menus; you'll see how to use them a little later. (22) The icons on your desktop always let you know what's available. (23) Right now you see icons that represent

- the System Tool disk you inserted
- the Trash, where you can discard what you don't need anymore.
APPENDIX C

Desk accessories

(1) You choose desk accessories from the Apple menu on the far left side of the menu bar. (2) Desk accessories are available while you're using the Finder or any application.

(3) You can use the Cut, Copy, and Paste commands in the Edit menu to move or copy text or pictures among desk accessories, or to and from a document in another window. (4) See "Editing Text" in Chapter 2.

(5) With most applications, you can keep one or more desk accessories open on your desktop while you work on documents. (6) Like any windows, desk accessories may be obscured by other windows that are made active. (7) The accessories can be made active by clicking them or choosing them again from the Apple menu, and moved by dragging their title bar. (8) You close them either by clicking their close boxes or by choosing Close from the File menu.

(9) With some applications (MacPaint, for example), you need to close desk accessories in order to work on a document.

(10) All desk accessories are closed automatically when you open a document or application from the Finder or quit an application.

(11) The Apple menu always contains the accessories that are installed in the System file on the current startup disk. (12) The System file on the System Tools disk includes seven desk accessories: Alarm Clock, Calculator, Chooser, Control Panel, Find File, Key Caps, and Scrapbook. (13) The Utilities disk includes two other desk accessories – Note Pad and Puzzle – in a desk accessory File in the Utilities folder. (14) You can add these accessories to any startup disk. (15) See the Macintosh Utilities User’s Guide for instructions on how to add or remove desk accessories.
## APPENDIX D

"Unpacking"

<table>
<thead>
<tr>
<th>Brand-New</th>
<th>Unused</th>
<th>Inferrable</th>
<th>Situational</th>
<th>Textual</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>the first <strong>thing to do</strong> everything you're supposed to</td>
<td>you</td>
<td>(this) (switch)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>everything <strong>listed here</strong></td>
<td>the materials</td>
<td>(you)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the packing box</td>
<td>(it) (switch)</td>
</tr>
<tr>
<td>Mac Plus main unit</td>
<td></td>
<td>Mac Plus</td>
<td></td>
<td>the Macintosh Plus</td>
</tr>
<tr>
<td>Power Cord</td>
<td>Keyboard</td>
<td>Your Apple...</td>
<td></td>
<td>you</td>
</tr>
<tr>
<td>Mouse...</td>
<td><em>Mac Plus</em></td>
<td><em>Mac Utilities...</em></td>
<td></td>
<td>everything</td>
</tr>
<tr>
<td><em>Mac Quick...</em></td>
<td><em>System Tools...</em></td>
<td><em>Utilities disk</em></td>
<td></td>
<td>the registration card</td>
</tr>
<tr>
<td>Registration card</td>
<td>Packing list</td>
<td>Programmer's switch</td>
<td></td>
<td>it (card)</td>
</tr>
<tr>
<td></td>
<td>(applications)</td>
<td></td>
<td></td>
<td>(The card)</td>
</tr>
</tbody>
</table>

(applications)
<table>
<thead>
<tr>
<th>Brand-New</th>
<th>Unused</th>
<th>Inferrable</th>
<th>Situational</th>
<th>Textual</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>your authorized dealer, rep.</td>
<td>anything</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>long distances (that is, any distance that requires a car or airplane)</td>
<td>the packing materials the box the packing materials your computer system you</td>
</tr>
</tbody>
</table>

"The tutorial"

<table>
<thead>
<tr>
<th>Brand-New</th>
<th>Unused</th>
<th>Inferrable</th>
<th>Situational</th>
<th>Textual</th>
</tr>
</thead>
<tbody>
<tr>
<td>A beep</td>
<td></td>
<td>the power</td>
<td>the disk drive</td>
<td>the Mac Plus the Mac Plus it (Mac Plus) you It (Mac Plus) you</td>
</tr>
<tr>
<td>a yellow sheet of plastic</td>
<td></td>
<td></td>
<td></td>
<td>the plastic piece the disk drive it (plastic) it the disk drive your Mac Plus</td>
</tr>
<tr>
<td>An icon (a small picture) representing a Mac disk a disk</td>
<td></td>
<td></td>
<td></td>
<td>the Mac Plus you the disk drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>the screen the blinking question mark the disk labeled System Tools metal end label side</td>
</tr>
<tr>
<td>Brand-New</td>
<td>Unused</td>
<td>Inferrable</td>
<td>Situational</td>
<td>Textual</td>
</tr>
<tr>
<td>-----------</td>
<td>--------</td>
<td>------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>information</td>
<td>Macintosh</td>
<td>The level you want</td>
<td>the Mac Finder, a special...</td>
<td>your screen</td>
</tr>
<tr>
<td>A message</td>
<td></td>
<td>the brightness control</td>
<td>This</td>
<td></td>
</tr>
<tr>
<td>one application another (application)</td>
<td>most computer screens</td>
<td>the departing flight...</td>
<td></td>
<td>It (Finder) your computer</td>
</tr>
<tr>
<td>a &quot;home base&quot;</td>
<td>a light gray desktop</td>
<td></td>
<td></td>
<td>the Mac Plus screen</td>
</tr>
<tr>
<td>any way you want a real desktop</td>
<td>documents folders things the mouse menus</td>
<td>your work what you want to work on next the mouse button</td>
<td></td>
<td>You</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>you them (menus)</td>
</tr>
</tbody>
</table>
"Desk Accessories"

<table>
<thead>
<tr>
<th>Brand-New</th>
<th>Unused</th>
<th>Inferrable</th>
<th>Situational</th>
<th>Textual</th>
</tr>
</thead>
<tbody>
<tr>
<td>desk accessories</td>
<td>the Apple menu  the far left side of the menu bar</td>
<td>You</td>
<td>Desk accessories  you  You desk accessories</td>
<td></td>
</tr>
<tr>
<td>the Finder  any application</td>
<td></td>
<td></td>
<td>you</td>
<td></td>
</tr>
<tr>
<td>the Cut, Copy  Paste commands  the Edit Menu  text  pictures  &quot;Editing Text&quot;  Chapter 2  most applications  one or more desk accessories  documents any windows</td>
<td>other windows  that are made active their title bar</td>
<td></td>
<td>the accessories  them (access.)  the Apple menu  You  them (access.)  the File menu  you desk accessories</td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td>their close boxes</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You

you

you

you

you

the icons on your desktop  what's available

icons that represent the S. Tool disk you inserted

what you don't need anymore

you
<table>
<thead>
<tr>
<th>Brand-New</th>
<th>Unused</th>
<th>Inferrable</th>
<th>Situational</th>
<th>Textual</th>
</tr>
</thead>
<tbody>
<tr>
<td>a document</td>
<td></td>
<td></td>
<td></td>
<td>all desk accessories you the Finder the Apple menu</td>
</tr>
<tr>
<td>a document or application an application</td>
<td></td>
<td>the accessories that are installed in the System... the System File on the System Tools... seven accessories [list]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Utilities Disk</td>
<td></td>
<td>two other desk accessories—Note Pad and Puzzle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a desk accessory file</td>
<td>The Utilities Folder</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>any startup disk</td>
<td></td>
<td></td>
<td></td>
<td>You</td>
</tr>
<tr>
<td>the Mac Utilities User's Guide</td>
<td></td>
<td></td>
<td>instructions on how to add or remove desk accessories</td>
<td></td>
</tr>
</tbody>
</table>